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Welcome! 
Overview of Scholarships & Financial Aid: 

The Office of Scholarships & Financial Aid is a part of the Division of Enrollment & Academic Services, which reports to 
the Office of the Provost. It is responsible for scholarships and financial aid processing and advising, student 
employment, veteran services, and financial education for Texas A&M University. The office is broken down into teams, 
which have different responsibilities and are run by team managers. This is Team Money, which addresses the financial 
education portion of Scholarships & Financial Aid, and Nick Kilmer is the team manager. Team Admin oversees the team 
managers. See the New Employee Manual for Orientation (NEMO) you were given for more details. 

 

Background on the Money Wise Aggie Program: 

Since 2005, Texas A&M University has provided financial literacy information to students. The Money Wise Aggie (MWA) 
program was established in 2007 to help students make smart personal finance decisions while pursuing their academic 
degrees, in order to lay a foundation for financial success throughout life. It provided workshops, classroom 
presentations, student group presentations, one-on-one advising, and online resources to Texas A&M students 
interested in learning about budgeting, credit cards, credit scores, student loans, investing, identity theft, and more. 
From its inception, one full-time advisor coordinated the program with part-time assistance from other Scholarships & 
Financial Aid advisors who helped to provide the MWA workshops in the Pavilion each semester. In Fall 2016, the Money 
Wise Aggie Program was replaced by the new Money Education (ME) Center (see below).  

 

Overview of the Money Education Center: 

Scholarships & Financial Aid was approved to develop a financial education center, called the Money Education (ME) 
Center in 2015. In Fall 2016, the university opened the Money Education (ME) Center within Scholarships & Financial 
Aid. The ME Center helps students to limit the net cost of attending college, navigate unexpected financial barriers to 
graduation, minimize student loan debt and default, and prepare for a lifetime of financial decisions. Through 
presentations, scheduled appointments, walk-in advising, online resources, and our 3 credit hour course (AGEC 235), 
The ME Center has educated over 23,000 different individuals since opening.  
 
The Money Education website is money.tamu.edu. Visitors can view our presentation schedule, request a presentation, 
schedule an appointment, ask questions, give feedback, and more. Students, faculty, and staff interested in contacting 
the ME Center can do so through our website, by emailing money@tamu.edu, by calling 979-845-SAVE (7283), or 
through social media on Facebook at /aggiemoneyeducation or Twitter @AgsToRiches. 

 

The Peer Advising Program: 

Former AGEC 235 students are trained as Peer Advisors to provide presentations, one-on-one advising sessions, 
delinquent borrower calls, assist with AGEC 235 class management, front desk coverage, and event coordination 
amongst other duties. Review the “Meet Our Team” section of money.tamu.edu to learn more about each Peer Advisor.  

 

http://www.money.tamu.edu/
mailto:money@tamu.edu
http://www.money.tamu.edu/


 
 

Getting Started 
 
General Information:  

The following are a few things which you will need to know as an employee of the office.  

• Staff are expected to dress professionally. Jeans are allowed on Friday (unless you are presenting or have an 
important meeting), but tennis shoes are not allowed.  

• The breakroom upstairs has coffee, tea, cocoa, and filtered water.  You can store your food in the refrigerator 
and use the microwaves and toaster oven. The refrigerator is emptied out every Friday. A mini-fridge and coffee 
maker are also located in the ME Center as well.  

Initial Setup: 

The following needs to be completed shortly after starting work: 

• Meet all of the Assistant Directors, Associate Directors, Directors, and the Assistant Vice President. 
• Have your picture emailed to the entire office.  
• Have IT setup your computer access. Don’t forget the following: 

o Access to the money@tamu.edu email inbox  
o Access to the money@tamu.edu team Outlook Calendar 
o Access to the phone/lobby coverage team Outlook Calendar 
o Access to the Team Money shared folder  
o Be added to the SFAID – TeamMoney email distribution group 
o Be added to the SFAID – OfficeEveryone email distribution group  

• Gain access to SWAN (Student Walk-Ins, Appointments, & Notes).  
• Gain access to ERS (Event Registration System).  
• Complete all required online trainings through TrainTraq in sso.tamu.edu. 
• Gain access to BANNER and nslds.ed.gov. 
• Receive an office polo & t-shirt.  
• Set up your office email signature according to the email signature document in this binder. 
• Become familiar with the staff and office environment by reviewing the office organizational chart and office 

map in this binder.   
• Read the SWAN Money Education Center Manual included in this binder.  
• Read the Money Education Center Presentation & Resource Table Manual in this binder.  

 

 

 

 

 

 

 

mailto:money@tamu.edu
mailto:money@tamu.edu
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http://ers.tamu.edu/
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https://www.nslds.ed.gov/nslds/nslds_SA/


 
 
Expectations: 

• 5 Keys to Being a Successful Employee 
o Be on time (emergencies happen) 
o Don’t cause drama: 
o Complete all of your basic job duties 
o Make your boss’s life easier 
o Willingly accept and seek out opportunities for development or growth 

• Attire 
o In order to create an environment that is viewed as professional and reliable, it is your responsibility to 

present yourself appropriately. Staff are expected to dress professionally when at work. You will be given a 
Money Education polo which you should wear at presentations and resource tables. 

• Behavior 
o It is expected that the language used when interacting with students, co-workers, and staff within the center 

is appropriate and professional.  
o Be punctual. 
o Provide advance notice of schedule changes.  
o Notify your supervisor as soon as possible if illness/emergencies come up that prevent working. 
o Strive to grow and develop (take on challenges). 
o Ask for help when you need it. Never give out false information.  
o Keep interactions confidential.  
o Don’t judge.  
o Be flexible.  

• Front Desk 
o Present yourself in a professional manner.  
o Be eager and prepared to answer any questions that students entering the ME Center may have. 
o Use headphones when viewing videos or other content that has audio. 

• Email 
o Respond to emails in the money@tamu.edu email inbox within 1 business day.  
o Forward emails in the money@tamu.edu email inbox to the appropriate person when necessary.  
o Move emails to which you have responded to appropriate sub-folder in the money@tamu.edu inbox. 

• Main Phone Line 
o When answering the phone, be kind and inviting. 
o If a caller asks a question for which you do not have an answer, ask them if they can hold or be called back 

(if they are unable to hold) so you can get the correct answer for them. Don’t guess! 
• Scheduling 

o Schedule advising appointments upon student request (via email, phone, or walk-in) through SWAN (see the 
SWAN Manual for details). Students can also do so themselves on our website.  

• Presentations 
o A presentation coordinator will assign presentations to the appropriate presenter.  
o All elements of training for a particular topic must be completed before presenting will be allowed.  

• Advising 
o Do not give blind advice on a topic you do not thoroughly understand. It is OK to confirm information with 

one of the other advisors or let the student know that another advisor can answer their question. 
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Initial Training 
Day 1 Agenda: 
(45 minutes) Introduction to ME Center & SFAID 

o ME Center purpose and services  
o Staff directory and organizational structure 
o 5 Keys to Being a Successful Employee 
o Office and breakroom tour 
o Printers, copiers, and scanners 

(90 minutes) Outlook (Rearrange if IT is not ready) 
o Computer setup  
o Email signature setup 
o Semester work schedule preparation 
o Outlook Calendar event setup (including weekly 

30 minute meeting) 
o Outlook Email folder setup 
o Outlook Email cell phone setup  
o money@tamu.edu Outlook Email Inbox 

(30 minutes) SWAN 
o Proper lobby behavior 
o Lobby student sign-in process (SWAN) 
o Student appointment scheduling (SWAN) 
o Student note taking/tracking (SWAN) 

Day 2 Agenda: 
(75 minutes) ERS & Money Inbox 

o Event (presentation/resource table) creation 
process and expectations 

o Adding events to money@tamu.edu Calendar 
o adding/deleting events in ERS 
o Inputting student rosters for events in ERS 
o The Rule of 25 (registration links) 
o Proper email etiquette (pictures with snipping 

tool and email templates) 
o Replying to event requests (email templates) 
o Practice event creation process from beginning to 

end (Class and Student Group) 
(10 minutes) O DRIVE  

o Accessing the team shared drive 
o Computer task bar pinning 

 
 
 
 

 
(50 minutes) Financial Aid / Moses / Compass 

o Financial aid basics (Navigate Website) 
o Compass (RRAAREQ, RHACOMM, RPAAWRD, 

SPAIDEN) 
o Financial Aid Portal (clearing student 

requirements) 
o Department Intranet (MOSES) 
o National Student Loan Data System 

Day 3 Agenda: 
(30 minutes) Resource Tables & Who We Are 

o Articulating our purpose and services  
o Practice elevator speech (ME Center Handout) 
o Incorporate Center overview into walk-in advising 

(45 minutes) Presentation Preparation Presenting Process 
o Recording student attendance (UINs) 
o Preparing for a presentation (logistics) 
o Practicing a presentation (slide goals, value 

added, stories) 
o Practice, Practice, Practice (book practice room) 

(60 minutes) Live Presentation 
o Example presentation (money management) 
o Handling tough questions  

Day 4 Agenda: 
(40 minutes) Preparation for Advising  

o Student sign-in process 
o Sit in on other advisor’s appointments 
o Review appropriate note taking (SWAN) 
o Adding appointment availability (SWAN) 

(60 minutes) Advising Process 
o Review Advising Others Presentation 
o Handling tough questions 

(15 minutes) SSO (Ask David for help as needed) 
o Submitting timesheets (set Outlook reminders) 
o Required trainings  
o Setup Direct Deposit  

(20 minutes) Wrap Up 
o Discuss personal goals 
o Complete knowledge assessment 
o Discuss binder importance 
o Questions? 
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Ongoing Training 
Trainings: 

Below are the topics which you should focus on initially.  After mastering these topics, you will be able to move on to 
additional topics (Saving & Investing, Love & Money, Credit Cards & Credit Scores, etc.).  

   
Money 

Management 
Repaying 

Student Loans 
Annual Loan 
Counseling 

Read through the PowerPoint presentation       
Observe the presentation live    
Develop your own version of the presentation       
Book PAV 106AD and Practice Present (Min. x3)    
Take Knowledge Assessment over the Topic    
Mock present the presentation       
Present while being monitored by a Staff Member       
Cleared to Present on this Topic       
Observe 5 appointments       
Advise while being monitored by a Staff Member       
Cleared to Advised on this Topic       

 
Peer Advisor Presentation Checklist: 
1 Week before Presentation 
               Review presentation slides for typos and full functionality 
               Practice present AT LEAST 2-3 times 
               Review details of the presentation (know who you are presenting to) 
Day before Presentation 
               Find the location of your presentation 
               Schedule travel time and find parking options  
               Save your presentation in multiple forms (email, flash drive, physical copy) 
               Confirm the presentation with a staff member (Student Group Presentations) 
Day of Presentation 
               Wear ME polo and appropriate presenting attire 
               Do you have your presentation with you? 
               Do you have the presentation roster and pen?               
               Do you have the clicker if you plan on using it? 
               Do you have the ME handouts for your presentation topic?               
               Do you have ME Center giveaways if you plan on using them? 
               Review presentation one last time 
               Show up in presentation room 15 minutes before the start of the presentation 
               Test your videos and any external content that you are using for the presentation 
               Text David 10 minutes before presentation to confirm attendance  
After the Presentation 
               Bring roster, clicker, and leftover materials back to ME Center 
 



 
 

Advising 
 

General Information: 

Private advising sessions will almost always be by appointment. Appointments will be scheduled online through SWAN. 
Students can do so on the Contact Us page of money.tamu.edu or a staff member can do it for them directly through 
SWAN. See the Money Education SWAN Manual for more information regarding this. Walk-In Advising is available in the 
lobby Monday thru Friday, 8am-5pm.  

 

Expectations and Recommendations: 

Keep in mind your limitations when advising. The worst thing you can do is give advice that is not accurate or 
advantageous to the specific situation of the student you are advising. If a student asks a question that you do not know 
the answer to, you should either let the student know that you will do research to find the answer, or refer them to 
someone else within the center who is more qualified to answer their question.  

It is vital that a student coming in to receive advice feels welcome and able to share openly. For this reason, it is 
important to convey a judgement-free zone. By eagerly listening and analyzing what the student has to say, you enable 
them to feel that they can share their current financial status openly, and in turn, create the opportunity for relatability 
between peers. Being able to relate to the students you advise is a major advantage.   

 

Steps for Successful Advising Sessions:

 

 

Before 
Meeting

•Schedule appointment
•Review SWAN notes
•Have student sign-in and remove from waitlist before meeting
•Grab ME binder and bring to meeting

During 
Meeting

•Greet student and get to know them
•Ask questions to determine student's issue(s)
•Recommend action items to help achieve goals
•Give student handouts/brochures that may be helpful

After 
Meeting

•Log meeting notes into SWAN
•Send follow-up e-mail
•Copy and paste e-mail into SWAN
•Shred meeting notes

http://www.money.tamu.edu/


 
 

 
Money Education (ME) Center Peer Advisor  

CONFIDENTIALITY AGREEMENT 
 

 
I hereby agree that I will comply with Texas A&M University’s Money Education (ME) Center 
policies, procedures, and ethical standards regarding customer confidentiality. I will maintain the 
confidentiality of customers and I will not disclose any personally identifiable customer information. 
I will respect customer privacy and the confidentiality of the customer/Peer Advisor relationship. 
Such matters will not be discussed outside of the Money Education (ME) Center Peer Advisor 
supervisory staff. 
 
By signing this agreement, I agree to fulfill in good faith the confidentiality requirement set forward 
herein and be strictly guided by this agreement in all my activities related to Money Education (ME) 
Center Peer Advising. 
 
I understand that any violation may result in removal from the Money Education (ME) Center Peer 
Advising Program. 
 
 
Printed Name:            
 
 
Signature:                 
 
 
Date:                 

 

 
 
 

 



 
 
Add a Signature to Messages: 

1. On the Home tab, choose New Email. 
2. On the Message tab, in the Include group, choose Signature > Signatures. 

 
3. Under the Select signature to edit, choose New, and in the New Signature dialog box, type a name for the 

signature.  
4. Under Choose default signature, do the following: 

a. In the E-mail account list, choose an email account to associate with the signature. 
b. In the New messages list, choose the signature that you want to be added automatically to all new email 

messages. If you don’t want to auto sign your email messages, accept the default option of (none).  
c. In the Replies/forwards list, choose the signature that you want to be added automatically (auto sign) when 

you reply to or forward messages. Otherwise, accept the default option of (none). 
5. Under Edit signature, type the signature, and then choose OK. 
 

Add Social Media Links to Your Signature:  

1. In Outlook, on the Home tab, choose New Email.  
2. On the Message tab, in the Include group, choose Signature > Signatures. 
3. On the E-mail Signature tab, choose New. 
4. Type a name for the signature, and then choose OK. 
5. In the Edit signature box, type the text that you want to appear for this new signature and use the mini formatting 

toolbar to style your entry as you desire. 
a. Tip: Press Enter after typing text for the new signature to make sure the icons you add are aligned on a 

single line.  
6. Choose Picture, go to the Desktop folder, and then choose the social networking service icon you saved. 
7. Choose Insert > Hyperlink. 
8. In the Address box, enter the web address—for example, http://www.facebook.com/username—for your Facebook, 

Twitter, or other social network account that corresponds to the icon, and then choose OK. 
a. Note: If you have more than one icon to add, repeat steps 6 through 8 for each icon you want to add. 

9. Choose OK to finish creating the new signature.  
10. Inside the body of the message, on the Message tab, in the Include group, choose Signature and choose your newly 

created signature.  

Jane Doe 
Peer Advisor 
Money Education (ME) Center 
Scholarships & Financial Aid 
Texas A&M University 
janedoe@tamu.edu 
 
P.O. Box 30016 | College Station, TX 77843  
Tel. 979.458.5325 | Fax. 979.847.9061  
money.tamu.edu | Facebook | Twitter 

mailto:janedoe@tamu.edu
http://moneywise.tamu.edu/
http://www.facebook.com/moneywiseaggie
http://www.twitter.com/#AgsToRiches
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